Problem Determination Guide
Before using this information and the product it supports, read the information in Appendix B, “Notices,” on page 35.
# Contents

**About this guide** ........................................... vi
  Who should read this guide ................................ vi
  What this guide contains ................................... vi
  *Publications* ............................................. vi
    - IBM Tivoli Resource Model Builder library ........... vi
    - Related publications ................................ vi
    - Accessing publications online ....................... vi
    - Ordering publications ................................ vii
  *Accessibility* ........................................... vii
  *Contacting software support* ............................ vii
  *Conventions used in this guide* ......................... viii
    - Typeface conventions ................................ viii

**Chapter 1. Introduction to problem determination** .... 1
  *Product overview* ....................................... 1
  *Built-in problem determination features* ............... 1
  *Problem classification* ................................ 1

**Chapter 2. Troubleshooting installation** ................. 3
  *Product installation overview* ........................... 3
  *Installation troubleshooting* ............................. 3

**Chapter 3. Common problems and frequently asked questions** ... 5
  *Creating resource models* ............................... 5
  *Editing resource models* ................................ 6
  *Testing and debugging resource models* ............... 8
  *Generating resource model components* ................. 9
  *Logging* .................................................. 10
  *Windows* .................................................. 10
  *Printing* .................................................. 11
  *Support options* ........................................ 11

**Chapter 4. Understanding informational, warning, and error messages** ... 13

**Chapter 5. Trace logging and First Failure Data Capture** ...... 23
  *Trace logging overview* ................................ 23
  *Trace log location* ..................................... 23
  *Trace log format* ....................................... 24
  *Trace log example* ..................................... 25
  *First Failure Data Capture overview* .................... 25
  *Native trace logging* ................................... 26

**Chapter 6. Logging configuration** .......................... 27
  *Configuration options* .................................. 27
    - Logging preference window .......................... 27
    - Output window ....................................... 28
    - Native code logging window ......................... 30

**Appendix A. Accessibility** ................................ 33
  *Using assistive technologies* .......................... 33
  *Magnifying what is displayed on the screen* .......... 33
  *Documentation in accessible formats* .................. 33
  *Using alternative text* ................................ 33

**Appendix B. Notices** .................................... 35
  *Trademarks* ............................................. 37

**Index** ..................................................... 39
About this guide

This guide provides problem determination and resolution information for the issues most commonly encountered with IBM® Tivoli® Resource Model Builder. You can use this guide in conjunction with the *IBM Tivoli Resource Model Builder User’s Guide*, which contains installation and function procedures.

This guide can assist you in investigating problems you might have with IBM Tivoli Resource Model Builder, and isolating these problems using diagnostic information. When you isolate a problem, you can search known problems, and identify circumvention and workarounds. By being familiar with known problems, you can avoid potential problems. You can achieve these objectives by reviewing common problems and frequently asked questions regarding IBM Tivoli Resource Model Builder.

Who should read this guide

This book is for administrators who need to know how to resolve issues with IBM Tivoli Resource Model Builder. Readers should be familiar with the following:

- Windows® or UNIX® operating systems
- Tivoli environment
- IBM Tivoli Monitoring

What this guide contains

This guide contains the following sections:

- **Chapter 1, “Introduction to problem determination,” on page 1**
  Provides an overview of problem determination concepts used to troubleshoot IBM Tivoli Resource Model Builder issues.

- **Chapter 2, “Troubleshooting installation,” on page 3**
  Provides information on troubleshooting the installation for IBM Tivoli Resource Model Builder.

- **Chapter 3, “Common problems and frequently asked questions,” on page 5**
  Provides common problems and frequently asked questions for IBM Tivoli Resource Model Builder.

- **Chapter 4, “Understanding informational, warning, and error messages,” on page 13**
  Provides an explanation of message identification and lists the IBM Tivoli Resource Model Builder messages.

- **Chapter 5, “Trace logging and First Failure Data Capture,” on page 23**
  Provides trace log information for IBM Tivoli Resource Model Builder.

- **Chapter 6, “Logging configuration,” on page 27**
  Provides configuration information to optimize IBM Tivoli Resource Model Builder.
Publications

This section lists publications in the IBM Tivoli Resource Model Builder library and related documents. It also describes how to access Tivoli publications online, and how to order Tivoli publications.

IBM Tivoli Resource Model Builder library

The following guides are available in the IBM Tivoli Resource Model Builder library:

  Describes how to install, configure, and use IBM Tivoli Resource Model Builder.

  Provides the latest information about known product limitations and workarounds.

Related publications

To use the information in this book effectively, you must have some prerequisite knowledge, which you can find in the following books:

- **IBM Tivoli Monitoring User’s Guide**
  Provides detailed information about using IBM Tivoli Monitoring.

- **Tivoli Management Framework User’s Guide**
  Provides detailed information about profiles and profile management.

- **Tivoli Management Framework Planning and Installation Guide**
  Provides detailed information about server and hardware requirements.

- **Tivoli Management Framework Reference Guide**
  Provides additional information about command line commands, such as the `winstall` command.

- **Tivoli Enterprise Console User’s Guide**
  Provides more detailed information about using the Tivoli Enterprise Console.

- **Tivoli Business Systems Manager User’s Guide**
  Provides more detailed information about using Tivoli Business Systems Manager.

The following documents also provide useful information:

The **Tivoli Software Glossary** includes definitions for many of the technical terms related to Tivoli software. The **Tivoli Software Glossary** is available, in English only, at the following Web site:

http://publib.boulder.ibm.com/tividd/glossary/termsmst04.htm

Accessing publications online

IBM posts publications for the IBM Tivoli Resource Model Builder at the following Web address:


This documentation is also available, along with other Tivoli product documentation, on the Tivoli Software Information Center Web site. The Tivoli Software Information Center is located at the following Web address:
Click the IBM Tivoli Monitoring link to access the product library.

The format of the publications is PDF, HTML, or both.

Note: If you print PDF documents on other than letter-sized paper, select the Fit to page check box in the Adobe Acrobat Print window. This option is available when you click File → Print. Fit to page ensures that the full dimensions of a letter-sized page print on the paper that you are using.

Ordering publications

You can order many Tivoli publications online at the following Web site:


You can also order by telephone by calling one of these numbers:

- In the United States: 800-879-2755
- In Canada: 800-426-4968

In other countries, see the following Web site for a list of telephone numbers:

http://www.ibm.com/software/tivoli/order-lit/

Accessibility

Accessibility features help users with a physical disability, such as restricted mobility or limited vision, to use software products successfully. With this product, you can use assistive technologies to hear and navigate the interface. You can also use the keyboard instead of the mouse to operate all features of the graphical user interface.

For additional information, see the Appendix A, “Accessibility,” on page 33.

Contacting software support

Additional support options are listed in “Support options” on page 11.

If you have a problem with any Tivoli product, refer to the following IBM Software Support Web site:


If you want to contact software support, see the IBM Software Support Guide at the following Web site:

http://techsupport.services.ibm.com/guides/handbook.html

The guide provides information about how to contact IBM Software Support, depending on the severity of your problem, and the following information:

- Registration and eligibility
- Telephone numbers and e-mail addresses, depending on the country in which you are located
• Information you must have before contacting IBM Software Support

Conventions used in this guide

This book uses several conventions for special terms and actions, operating system-dependent commands and paths, and margin graphics.

Typeface conventions

This guide uses the following typeface conventions:

**Bold**
- Lowercase commands and mixed case commands that are otherwise difficult to distinguish from surrounding text
- Interface controls (check boxes, push buttons, radio buttons, spin buttons, fields, folders, icons, list boxes, items inside list boxes, multicolon lists, containers, menu choices, menu names, tabs, property sheets), labels (such as Tip, and Operating system considerations)
- Keywords and parameters in text

*Italic*
- New terms defined in text
- Variables and values you must provide

**Monospace**
- Examples and code examples
- File names, programming keywords, and other elements that are difficult to distinguish from surrounding text
- Message text and prompts addressed to the user
- Text that the user must type
- Values for arguments or command options
Chapter 1. Introduction to problem determination

This problem determination guide explains how to troubleshoot IBM Tivoli Resource Model Builder. Previously, this product was called IBM Tivoli Monitoring Workbench.

Troubleshooting, or problem determination, is the process of determining why a certain product is malfunctioning. This chapter introduces troubleshooting as a high-level concept, and then relates it back to the product.

Product overview

IBM Tivoli Resource Model Builder, Version 1.1.3, is a programming tool for creating, modifying, testing, and packaging resource models for use with IBM Tivoli Monitoring products. IBM Tivoli Resource Model Builder enables you to specify events, parameters, and thresholds for existing and new resource models. You can identify problems in real time, notify administrators, and take autonomic, corrective action. New features for IBM Tivoli Resource Model Builder, Version 1.1.3 include:

- A standard user interface based on IBM Eclipse SDK
- A wizard to create and edit resource models
- A mechanism to specify events, parameters and thresholds
- Standard output in Visual Basic or JavaScript™

Built-in problem determination features

The primary troubleshooting feature in IBM Tivoli Resource Model Builder is logging. Logging refers to the text messages and trace data generated by IBM Tivoli Resource Model Builder. Messages and data are sent to an output destination, such as a console screen or a file. Typically, text messages relay information about a system’s or application’s state and performance. Messages also alert the system administrator to exceptional conditions when they occur.

Trace data captures transient information about the current operating environment when a component or application fails to operate as designed. IBM Software Support personnel use the captured trace information to determine the source of an error or unexpected condition. See Chapter 4, “Understanding informational, warning, and error messages,” on page 13 for more information on messages. See Chapter 5, “Trace logging and First Failure Data Capture,” on page 23 for more information on tracing.

Problem classification

Problems in IBM Tivoli Resource Model Builder fall into three categories:

- Installation
- Operations
- Logging

Installation problems usually involve missing prerequisite software and insufficient disk space. These problems are usually encountered before the installation can
complete successfully and are fairly straightforward to correct. See Chapter 2, “Troubleshooting installation,” on page 3 for more information.

Operation problems can include incomplete setup of a Tivoli Management Project, inability to execute commands, and a sudden lack of event transmission or correlation and unexpected program termination. These problems might require increased tracing and debugging attempts. Sometimes the resolution involves a simple change to the installed software, but there can also be instances where the resolution requires IBM Software Support. See Chapter 3, “Common problems and frequently asked questions,” on page 5 for more information.

Logging problems often involve incomplete logging results. See Chapter 6, “Logging configuration,” on page 27 for more information.
Chapter 2. Troubleshooting installation

This chapter explains how to troubleshoot problems during the installation process and perform recovery actions.

See the IBM Tivoli Resource Model Builder User’s Guide for additional information about installation.

Product installation overview

Two installation options are available for your environment. Since IBM Tivoli Resource Model Builder requires IBM Eclipse SDK, you can choose to install both products in one installation process. Alternatively, you can install only the IBM Tivoli Resource Model Builder if your environment already has IBM Eclipse SDK.

See the IBM Tivoli Resource Model Builder User’s Guide for installation requirements and procedures.

Installation troubleshooting

The following issues might occur when installing or uninstalling IBM Tivoli Resource Model Builder:

Can I install IBM Tivoli Resource Model Builder into an environment that has IBM Tivoli Monitoring endpoints?

Yes, you can install IBM Tivoli Resource Model Builder and both products can coexist peacefully. However, if you uninstall one of the products, the other will not function. You must uninstall both and reinstall the product you want to keep.

I installed IBM Tivoli Resource Model Builder into an environment that already had IBM Eclipse SDK. Why does IBM Tivoli Resource Model Builder not seem to be operating correctly?

When you install IBM Tivoli Resource Model Builder into an environment that already has IBM Eclipse SDK, the installer displays a series of prompts to complete the installation. Answering incorrectly to these prompts might cause IBM Tivoli Resource Model Builder to operate incorrectly, or not at all. To successfully complete the installation, do the following:

1. Select Yes to the installer window that asks, "You have updates. Do you wish to open the Update Manager now?"
2. After the Configuration Changes window appears, select the check box for Resource Model Builder (1.1.3), then click Finish.
3. After the Resource Model Builder (1.1.3) feature has been enabled, another prompt asks, "You will need to restart the workbench for the changes to take effect. Would you like to restart now?" Select No.
4. Close the IBM Eclipse SDK to return to the Installer.
5. Complete the installation steps and launch IBM Tivoli Resource Model Builder from the Start Menu (Start->Programs->IBM Tivoli Resource Model Builder->Resource Model Builder).

Why do some Arabic characters appear garbled or are replaced with squares in the installation dialogs?

The version of InstallShield Multi-Platform that IBM Tivoli Resource Model
Builder 1.1.3 uses for backward compatibility does not support Arabic language, therefore some characters in the dialogs do not display properly.

I uninstalled IBM Tivoli Resource Model Builder, so why are three MOF files remaining in WMI?
During installation, three MOF files (TMW_base10.mof, TMW_Resources10.mof, and ILTManagerforJava.mof) are added to WMI. These files provide the WMI classes for the standard Tivoli WMI interfaces. The definitions contained by these files are not removed from WMI when the software is uninstalled, because these files are required by IBM Tivoli Monitoring.

If you do not have IBM Tivoli Monitoring or IBM Tivoli Monitoring components on your endpoints or system, you can optionally choose to remove these files manually.

If you removed the files, but need to them replaced in your environment, you can reinstall IBM Tivoli Resource Model Builder to replace these files.

During my uninstall of IBM Tivoli Resource Model Builder, a warning occurred. What should I do?
During the uninstall, the following warnings might occur:
- “Could not delete product uninstaller resources.”
- “One or more errors occurred during the unregistration of files. Refer to the uninstall log for additional information.”

The issues described in these warnings do not harm your environment. If you choose, you can manually delete the IBM Tivoli Resource Model Builder installation directory, including the log.txt file.
Chapter 3. Common problems and frequently asked questions

This chapter contains common problems and frequently asked questions grouped into the following categories:

- Creating resource models
- Editing resource models
- Testing and debugging resource models
- Generating resource model components
- Logging
- Windows
- Printing
- Support options

Creating resource models

Why do I get an error when I launch a resource model creation wizard?

After installing IBM Tivoli Resource Model Builder, you must create a Tivoli Management Project before you can create a resource model with any resource model creation wizard. Perform the following steps to create a Tivoli Management Project:

1. Select File from the toolbar to display the File drop-down list.
2. Select New from the toolbar to display the New pop-up list.
3. Select Project to display the New Project window.
4. Select Tivoli Management Project from the left field to display it in the right field.
5. Click on Tivoli Management Project in the right field to highlight the name.
6. Click Next to display the Project Name window.
7. Enter a name for the project in the Project name text box.
8. (Optional) Clear the Use default check box and specify a different directory location for the project.
9. Click Finish.

Why am I getting an error for the resource model internal name?

Internal names are handled differently between the Basic Resource Model Wizard and the Resource Model Editor.

When creating resource models with the Basic Resource Model Wizard, internal names for resource models and their components (such as events, and parameters) must start with a letter and contain only alphanumeric and underscore characters (_).

In the editor pages, however, you can change internal names to start with a number or contain characters other than an underscore. When you save the resource model, the editor creates an error marker in the Tasks view that is associated with each invalid internal name. During resource model creation, use only alphanumeric and underscore characters for internal names.
You can change the internal names later in the editor pages to include numbers and characters other than an underscore.

**Why am I getting an error about the parameter in my JavaScript resource model?**

The parameters of a JavaScript resource model cannot end in a backslash (\). This limitation occurs because parameters are written in the JS source code enclosed in double quotes, and the engine interprets " as a single character. This is a limitation caused by JavaScript syntax.

Modify the parameter name as needed, such as removing the last backslash. For example, "C:\testing\" can be modified to "C:	esting."

**Why did my CSL file import fail when I was using the Basic Resource Model Wizard?**

When importing a CSL file with the Basic Resource Model Wizard, a window prompts for the preprocessor options. If the preprocessor path and filename contain spaces, the path and filename must be enclosed in quotes. If they are not enclosed in quotes, the CSL file import fails.

**Why are some of my numeric CIM properties defined as String properties within the CIM class definition?**

If there are numeric CIM properties that can potentially return null values, these properties might be defined as String properties within the CIM class definition, and must be cast to numbers within the resource model script.

---

**Editing resource models**

**How do I use the management view?**

You can access the Management View from Window→Show View→Management.

The Management view shows Tivoli Management projects and resource models.

**Note:** Resource model outlines appear only when the resource model is in the root of a project. Resource models in subdirectories of a project
do not display an outline.

Expand any resource model to perform the following options from the outline:

- Copy and paste resource model elements into other resource models by right-clicking any event, parameter, threshold, or log attribute to copy and paste the element into another resource model.
- Change the internal name of a resource model element (except for log attributes) directly in the outline. Right-click on the element and select Rename to rename the element.

I closed the editor (or IBM Tivoli Resource Model Builder) while a script was running, and a JVM core dump occurred. What happened?

Closing the editor or IBM Tivoli Resource Model Builder while a script is running in the Visual Basic editor causes a JVM core dump (crash). If a file is dirty, a save prompt is opened that prompts for a save before the JVM crash occurs. Any other unsaved work might be lost.

Do not close the editor or IBM Tivoli Resource Model Builder while a script is running to avoid loss of data.

I am working in a double-byte environment, and I cannot see the text. Why?

In double-byte environments, the Visual Basic and JavaScript editors do not show the text in the language until you change the font to one that supports double-byte characters.

Change the text font to one that supports double-byte characters.

Why did I get an error when I specified a numeric range for the "Is out of the range" condition in the Event Triggering Condition window?

In the Event Triggering Condition window, when specifying an "Is out of the range" condition, the second value must be the larger value.

Use a numeric range that contains a second value larger than the first.

Why did I have a dirty flag set on my resource model when I closed out of the Event page?

In the Event page of the resource model editor, clicking Actions for an event (whether newly created or pre-existing, with or without actions) and then clicking Finish in the following screen without making any changes, results in a dirty flag being set. The resource model editor interprets this action to mean that the resource model changed.

If no changes were made in the Event page of the resource model editor, do not click Finish.

Why did I get an error when I tried to delete a file?

If a file is open in an editor and you try to delete it, you might receive an error stating that the file cannot be deleted.

To delete a file that is open, you must first close the file and then delete.

When I copy and paste Arabic strings from text files to the RMB editor pages, why do they fail to appear or become garbled?

The version of Eclipse/WebSphere Studio Workbench that IBM Tivoli Resource Model Builder uses for backward compatibility has limited BIDI support. This limitation can be encountered while working with the IBM Tivoli Resource Model Builder in an Arabic locale.
Testing and debugging resource models

What do I need to debug my JavaScript resource model?
Within IBM Tivoli Resource Model Builder, you can use the JavaScript Console and trace file to troubleshoot your resource model. In addition, you can use one of the following Microsoft® JavaScript debugging programs:
- Microsoft Visual Studio™
- Script Debugger for Windows™

For more information on resource model debugging, see the IBM Tivoli Resource Model Builder User’s Guide.

Where can I get an additional tool to debug my resource model code?
You can debug a JavaScript resource model with debugging tools, such as Microsoft Visual Studio or Script Debugger for Windows. If you do not have a debugging program in your environment, you can obtain a free program by searching for a script debugger, or by downloading one from the following Web site:


I ran a resource model to test it, but there is no logging data. Why?
By default, logging is disabled. Enable logging in the Decision Tree Script by doing the following:
1. Open the resource model and click on Source to view the Source window of the Editor.
2. In the SetDefaultConfiguration method, scroll down to the text that reads “Place your additional initializing code below.”
3. Type the following text into the script:
   Svc.EnableLogging(1)
4. Run the resource model again to log resource model data.

Why are some of my resource model JavaScript functions not working properly?
Windows 2000 ships with the JScript engine 5.1 version. The IBM Tivoli Monitoring engine supports the JScript engine 5.6 version on Windows. Depending on the JavaScript functions in a resource model, the JScript engine version 5.6 might be required.

You can download a free version of JScript 5.6 from the following Web site:


How do I interpret resource model states and actions?
In the following table, the first column lists the resource model states. The second column lists the return code ranges. The third column lists how Tivoli Monitoring interprets resource model states and the consequent actions it takes.

<table>
<thead>
<tr>
<th>Resource model state</th>
<th>Cause of the state</th>
<th>Action taken by the engine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed 1-200. The resource model has failed</td>
<td>VisitTree return code: 201-400</td>
<td>None</td>
</tr>
<tr>
<td>Failing 1-200. The resource model has an error.</td>
<td>VisitTree return code: 401-600</td>
<td>The engine automatically retries every three minutes to run the resource model.</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Retrying 1-200. The resource model is running</td>
<td>VisitTree return code: 601-800</td>
<td>Retries 3 times in each cycle time, indefinitely, to run the resource model.</td>
</tr>
<tr>
<td>Unable to start 1-200. The resource model is unable to start. Assumed missing prerequisites.</td>
<td>Init, or SetDefaultConfiguration return code: 801-1000</td>
<td>None</td>
</tr>
<tr>
<td>Recovering 1-200. The resource model is running</td>
<td>VisitTree return code: 1001-1100</td>
<td>Once per cycle, for three cycles only, tries to rerun the resource model. After three unsuccessful attempts, interprets the resource model as failed.</td>
</tr>
<tr>
<td>Failed after recovery</td>
<td>The resource model failed in three successive cycles. Interpreted as failed.</td>
<td>None</td>
</tr>
</tbody>
</table>

**The collection test does not return the expected results. Why?**

When running a collection test, you must use correct characters. If you use quotes and backslashes, those characters must be escaped with a backslash character. For example,

```plaintext
filename="c:\autoexec.bat"
```

should be entered as:

```plaintext
filename="c:\\autoexec.bat"
```

**I have an IBM Tivoli Monitoring 5.1.2 endpoint installed on the same machine as IBM Tivoli Resource Model Builder 1.1.3. Why can’t I run resource models with Java™ providers on this endpoint and use the IBM Tivoli Resource Model Builder concurrently?**

Because of architectural changes introduced with IBM Tivoli Monitoring 5.1.1 Fix Pack 6 and IBM Tivoli Monitoring 5.1.2 IBM Tivoli Monitoring 5.1.2 and IBM Tivoli Resource Model Builder 1.1.3 cannot be used concurrently. This is not a problem with earlier versions of IBM Tivoli Monitoring 5.1.1 (Fix Pack 5 and earlier).

**Generating resource model components**

**Why did I have a Java core exception when I exported my resource model?**

If you have a resource model with error markers, attempting to create the export package through the CLI causes a Java core exception (crash).

Check the Tasks view for listed resource model errors. Correct all errors before exporting a resource model.

**After I generated a file, the icon for the file did not appear in the view. What happened?**

When generating a resource model external file (such as an export package, resource model script, or HTML) to the current IBM Tivoli Resource Model Builder project’s directory in the operating system file system, the generated file’s icon does not immediately appear in the hierarchy of the Management Resource View or the Navigator View.
To display the generated file, right-click on the project and select "Refresh" from the list of options.

I am working in a double-byte environment and I installed IBM Tivoli Resource Model Builder 1.1.3 in a non-default environment. Why can’t I generate an AME zip file or a Java message catalog?
The version of Jikes, an IBM Java compiler that is included with this version of IBM Tivoli Resource Model Builder, does not support non-English characters. If the install directory of IBM Tivoli Resource Model Builder 1.1.3 contains non-ASCII characters, generating an AME zip file or a Java message catalog fails. Use the default installation directory for IBM Tivoli Resource Model Builder or use only ASCII characters in the install directory to prevent this problem.

Why did I get an error message and a tar package of 0 KB after creating some of the tar packages for the Classic Monitoring collection based Resource Model?
The error message indicates that the probes or monitors selected do not support at least one of the platforms selected for the resource model. Tar package creation discontinues to prevent deploying a resource model to a platform on where it will not work. Check the implementation of the probes or monitors you plan to deploy and obtain the names of the platforms supported. Select only those platforms in the Resource Model General Settings.

Logging

I turned the trace logging on, but no data was logged. Why?
Trace logging must be enabled in the Output window in order to store trace logging.

To enable trace logging, select the Enable trace logging to files option in the Output window. For more information, see “Output window” on page 28.

Windows

Why are some fields missing on my screen?
Some fields might not be visible in 800 x 600 screen resolution.
Set your screen resolution to at least 1024 x 768 view all fields.

Why is some text missing in some of my screens?
When a Windows desktop appearance setting for the Message Box font size is 11 or higher (regardless of resolution), text is not visible in some pages.

To view the complete text, set the Message Box font size to 10 or less.

Why does the IBM Tivoli Resource Model Builder closed unexpectedly while I am working on a large resource model?
The IBM Tivoli Resource Model Builder GUI can run out of Window handles if it contains a very large number of events, thresholds, and parameters. If this happens, restructure your monitoring into smaller resource models that are easier to maintain.

Why doesn’t the IBM Tivoli Resource Model Builder function properly on Windows 2000 Advanced Server?
The Windows 2000 Advanced Server is not technically supported because the IBM Tivoli Resource Model Builder requires the Dynamically Linked Library (dll) msvcp60.dll file, which is not installed by default on Windows
2000 Advanced Server. However, the IBM Tivoli Resource Model Builder can function on Windows 2000 Advanced Server if you copy the msvcp60.dll file from an existing Windows 2000 Professional installation from the %SystemRoot%\system32 directory into the same directory on the Windows 2000 Advanced Server system.

Printing

Can I print source script?
Yes, you can print source script. Do the following to print your source script:
1. From the resource model editor, click on the Script page.
2. Click File from the toolbar menu to display the File drop-down menu.
3. Click Print to display the Print configuration window.
4. Click OK to print the source script.

Why am I not able to print my script?
The JavaScript and Visual Basic script editors behave differently when a printer is not installed. In JavaScript, the "print" button is not enabled when a printer is not installed. In Visual Basic script, a window appears to install a printer.

Install a printer before attempting to print scripts.

Support options

What are my support options?
To test and execute your resource models, you need IBM Tivoli Monitoring, Version 5.1.1. Your active IBM Tivoli Monitoring support contract, available through Passport Advantage®, entitles you to interactive defect support and operational how-to questions about the IBM Tivoli Resource Model Builder tool, any code or scripts generated by IBM Tivoli Resource Model Builder, and the unmodified Best Practice Resource Model samples which are included in the IBM Tivoli Resource Model Builder. This support includes rapid responses to your requests, fast relief to high impact problems, timely problem resolution, high quality fixes and information, up-to-date service, and installation information. For more information, see the IBM Tivoli Monitoring home page:


If you need assistance with the design of your customized resource model, you can contact Tivoli Services for assistance. Tivoli Software Consulting Services:


Partnerworld for Developers members can purchase in-depth technical support for solution developers and ISVs developing on IBM platforms. For more information, refer to Technical Resources on the Tivoli Knowledge Center:

What do I need to prepare before I call IBM Software Support?

Contact IBM Software Support if you cannot resolve a problem using the troubleshooting information in this guide. Since IBM Software Support engineers ask a number of standard questions before troubleshooting a problem, you need to gather information before contacting them. This product contains scripts and tools for gathering the information you need to give IBM Software Support. Having the information ready in advance reduces the amount of time it takes the engineer to resolve the problem.

Use the following process to obtain the information that IBM Software Support needs to assist you:

- **Define the problem** - articulate the symptoms of the problem, provide any error messages or error output associated with the problem, and provide as many details related to the issue as possible.

- **Gather relevant information** - determine any associated software products and versions, the operating system and database platform and version, if this problem has occurred before or if this is an isolated incident, what occurred before the problem was detected, and if any changes have been made recently to the system. Collect the .metadata file located in the following directory: `<IESinstalldir>/eclipse/workspace/.metadata/`. This file contains the trace and message files used by support to replicate your environment. You can also collect any native logging files in C:\Default.log.

- **Determine the business impact** - determine how this affects your system and your ability to meet your business needs.

- **Collect the proper contact information** - your IBM Passport Advantage or Tivoli Customer ID, appropriate phone number or e-mail address, your preference of return correspondence: by phone or e-mail, alternate phone numbers (if possible), and if not responding to you, the name and contact information for the person IBM Software Support needs to contact.

Engineers also need the following product-specific information:

- Product version and release number
- Operating system information
Chapter 4. Understanding informational, warning, and error messages

This chapter introduces message logging, and explains how to gather information from those logs.

Message logging refers to the text and numeric messages created by IBM Tivoli Resource Model Builder. These messages relay information on how the system or application is performing and can alert you to exceptional conditions when they occur. Messages are sent to an output destination, such as a file, database, or console screen.

Messages are internationalized based on the locale of the message viewer and can be filtered based on a number of criteria.

The Tivoli Message Standard requires unique message identification numbers and help content fields for messages issued from a Tivoli component or application. This standard provides a consistent and meaningful way to identify messages across the entire Tivoli product suite.

If you receive a warning or error message, you can do one of the following:

• Follow the instructions listed in the Detail window of the message, if this is included in the message.
• Consult the message details listed in this chapter to see what action you can take to correct the problem.
• Consult the message log for message ID and text, time and date of message, as well as other data you can use to diagnose the problem.

Message log location and format

The following section explains where you can locate the message log file and how to interpret the log information.

Message log location

Messages are kept in rotating log files that follow the format “messageRMB.log, messageRMB1.log...” where messageRMB.log is the most recent log file. The number of message log files is configurable within the Output page as described in “Output window” on page 28

Message logs are located in the following directory:
<IESinstallldir>/eclipse/workspace/.metadata/tivoli/CTZ/logs

where:
<IESinstallldir>
Identifies the name of the IBM Eclipse SDK installation directory.

Message log format

The message log record format is as follows:

Date1<F>Date2<F>ProductID<F>Component<F>Server<F>ProcessID<F>
TraceLevel<F>FileName<F>Method<F>ThreadMessageId<F>LogText
Where:

**Date1**  Number of milliseconds elapsed between January 1st, 1970 and the log entry, for example, 1015343592000.

**Date2**  Date the log was produced specified as year, month and day.

**ProductID**

The three-letter code assigned to the product for identifying its messages uniquely. This is CTZ for the IBM Tivoli Resource Model Builder.

**Component**

Represents a run-time grouping of a product’s parts. If a product has multiple applications, the Component name reflects the name of the application.

**Server**

Host name (managed node label or endpoint label).

**ProcessID**

The Process ID of the process that produced the log message.

**TraceLevel**

Trace Level is an option for trace logs only. Message logs show a trace level of OTHER, by default.

**FileName**

Name of the file or class to which the trace refers.

**Method**

The method in the class to which the trace refers.

**Thread**

Thread to which the trace refers. Thread element refers to the platform-specific notion of a thread.

**MessageId**

The unique numeric message identifier.

**LogText**

The text of the message.

**Exception**

Exception element depends upon the specific language/platform.

**Message log example**

The following text shows an example of an error message recorded in the message log:

```
<F>1052255141784<F>2003-05-06<F>CTZ<F>RME<F>superhost<F>1<F>OTHER<F>
com.ibm.tivoli.monitoring.workbench.fileactions.PackageGenAction<F>run<F>main<F>
CTZRME035E The current resource model contains errors.: [Ljava.lang.String;@4fb2021d<F>None
```

Where:

**1052255141784**  Number of milliseconds elapsed between January 1st, 1970 and the log entry.

**2003-05-06**  Date the log was produced, listed in year, month, and day.

**CTZ**  The three letter code assigned to the product for identifying messages. CTZ is for the IBM Tivoli Resource Model Builder.
**RME** Represents a run-time grouping of a product’s parts. If a product has multiple applications, the Component name reflects the name of the application.

**superhost**
Host name (managed node label or endpoint label).

1 The Process ID of the process that produced the log message.

**OTHER**
Trace Level is an option for trace logs only. Message logs show a trace level of OTHER, by default.

**com.ibm.tivoli.rmb.ui.fileactions.PackageGenAction**
Name of the file or class to which the trace refers.

**run** The method in the class to which the trace refers.

**main** Thread to which the trace refers. Thread element refers to the platform-specific notion of a thread.

**CTZRME035E**
The unique numeric message identifier.

The current resource model contains errors.: [Ljava.lang.String;@4fb2021d
The text of the message.

None Exception element depends upon the specific language/platform.

---

**Product messages**

IBM Tivoli Resource Model Builder messages return in the form of 
<CCCYYYnnnS><message text>.

The following example shows a typical message and explains its identifying components:

**CTZRME401E** An error has occurred reading the specified dependency.

Where:

**CTZRME401E**
The message ID of the message. This ID is composed of the following:

- **CTZ** Identifies the message as belonging to IBM Tivoli Resource Model Builder.

- **RME** Identifies the component returning the message and can be one of the following IBM Tivoli Resource Model Builder components:
  - JRM — Java Resource Model message
  - JSE — Java Script Editor message
  - RME — Resource Model Editor message
  - TWE — Tivoli Workbench Environment message
  - VBE — Visual Basic for Applications Editor message

- **401** Identifies the unique serial number of the message.

- **E** Identifies the severity of the message as one of the following:
  - I Informational messages provide feedback about something that happened in the product or system that might be important. These messages can provide guidance when
you are requesting a specific action from the product. Informational messages are not documented in this guide.

**W**  
*Warning messages* call your attention to an exception condition. The condition might not be an error, but might cause problems if not resolved.

**E**  
*Error messages* indicate that an action cannot be completed because of a user or system error. These messages require user response.

An error has occurred reading the specified dependency.  
The log text of the error message.

## Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Explanation</th>
<th>Operator Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTZJRM108E</td>
<td>An error occurred while determining the build contributors for <em>PROJECT_NAME</em></td>
<td>This error comes from a utility method in ResourceModelPlugin. This method performs a check to see if IncrementalRMBBuilder is configured to run on a specified project. This error means the RMB was unable to determine this.</td>
<td>Make sure the project’s .project file is not corrupted. If it is, create a new Tivoli Management project and copy the buildContributor section from its .project file and place it into your bad .project file.</td>
</tr>
<tr>
<td>CTZJRM109E</td>
<td>Unable to access the file <em>FILE_NAME</em></td>
<td>Occurs when the ResourceModelFactory is unable to read the contents of the resource model’s file</td>
<td>Make sure you have permission to access the file. Its possible you may have deleted the file from outside Eclipse and failed to click “refresh” on the project.</td>
</tr>
<tr>
<td>CTZJRM110E</td>
<td>An error occurred while update the scripting code for the resource model.</td>
<td>Select details from the window to get specific information about this generic message.</td>
<td>Review the commented sections such as: //&lt;&lt;GENERAL_INFO&gt;&gt; in the SetDefaultConfiguration method</td>
</tr>
<tr>
<td>CTZJRM111E</td>
<td>No code generator could be found for the resource model file <em>RM_NAME</em></td>
<td>The file probably does not end with a .jrm or .vrm extension</td>
<td>Rename the file to have to appropriate file extension, .jrm for a Java Script resource model and .vrm for a VBA resource model.</td>
</tr>
<tr>
<td>CTZJRM113E</td>
<td>Unable to insert skeleton scripting code in the resource model</td>
<td>The file com/ibm/tivoli/rmb/model/codegen/JScriptSkeleton.js or com/ibm/tivoli/rmb/model/codegen/ VBASkeleton.js is not located in the jar file</td>
<td>Your ResourceModel.jar file located in the plugin com.ibm.tivoli.rmb.model_1.1.3 needs to be replaced with the original one.</td>
</tr>
<tr>
<td>CTZJRM114E</td>
<td>An error was encountered while parsing the file.</td>
<td>An error occurred trying to work with the workspace ZIP container</td>
<td>Make sure the file is in the ZIP format (will it open in WinZip?). Make sure there is a file named Model.xml in the zip file.</td>
</tr>
<tr>
<td>CTZJRM115E</td>
<td>An error occurred while parsing file’s xml description at row <em>ROW</em>, column <em>COLUMN</em></td>
<td>There is a problem with the workspace container file’s Model.xml. The Model.xml file in the workspace container has an xml error. Click details in the error window to retrieve the column and line number of the error.</td>
<td></td>
</tr>
<tr>
<td>CTZJRM116E</td>
<td><em>TAG_NAME</em> tag not found</td>
<td>The setDefaultConfiguration method needs code like: &lt;&lt;GENERAL_INFO&gt;&gt;&lt;&lt;\GENERAL_INFO&gt;&gt;Copy these tags from a good resource model and paste them into this resource model.</td>
<td></td>
</tr>
<tr>
<td>CTZJRM117E</td>
<td>No Text defined for Expert Advice</td>
<td>There must Text defined for ExpertAdvice. Actions are optional</td>
<td></td>
</tr>
</tbody>
</table>

16  IBM Tivoli Resource Model Builder: Problem Determination Guide
<table>
<thead>
<tr>
<th>CTZJRM118E</th>
<th>The file extension must be .jrm or .vrm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: The RMB can only read in models whose file extension is .jrm or .vrm.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Set the file extension to .vrm for VBA resource models or .jrm for Java Script resource models.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM149E</th>
<th>FATAL ERROR: DIR_NAME is a directory and cannot be added as a dependency.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: Resource Models require files for dependencies.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Make sure you add a file to the resource model as a dependency.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM150E</th>
<th>FATAL ERROR: The follow exception was caught while trying to run: VALUE_0 VALUE_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: This is a generic error message.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Access the stack trace to investigate the problem.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM151E</th>
<th>FATAL ERROR: The interp INTERP is not supported by the resource model: VALUE_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: The command, wrmbcli -setDep, ran and tried to add a dependency for an interp the resource model does not support.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Either choose an interp supported by the resource model, or add the interp to the resource model.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM153E</th>
<th>FATAL ERROR: The dependency file, FILE_NAME, does not exist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: You are trying to add a dependency to the model, but the dependency doesn’t exist on the file system.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Specify a valid filename. If its a long file name with spaces, it must be enclosed with quotes, such as: &quot;c:\long file\name.dep&quot;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM154E</th>
<th>FATAL ERROR: The directory, DIRECTORY, does not exist. The resource model cannot be extracted.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: The directory specified by the command does not exist.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM155E</th>
<th>FATAL ERROR: The file, FILE_NAME, does not exist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: The program was unable to find the specified file.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Make sure the file exists and you entered the path to it correctly.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM156E</th>
<th>FATAL ERROR: Only numbers are allowed for Major and Minor version.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: A non-numeric character was entered for either the major or minor version number.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Enter only numeric values for the major and minor version numbers.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM157E</th>
<th>FATAL ERROR: An error occurred while trying to write the file: VALUE_0 VALUE_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: The program was unable to write to the file.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Make sure you have permissions to write to the location, and that you have adequate disk space.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM158E</th>
<th>An error has occurred in the Java Resource Model plugin and a trace log has been created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: An error occurred in the Java Resource Model plugin. A trace log has been created in the Tivoli common log directory under &quot;CTZ\FFDC\Current Date&quot;.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Check the log file.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM159E</th>
<th>FATAL ERROR: The file FILE_NAME, does not exist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: No additional information is available for this message.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: If an absolute path was not specified, make sure the file is located in the current working directory.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CTZJRM160E</th>
<th>FATAL ERROR: The script FILE_NAME is incompatible with a workspace file of type FILE_TYPE.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation: When setting the script for a VB resource model, the script file must have the .vba extension. When setting the script for a JavaScript resource model, the script file must have the .js extension.</td>
<td></td>
</tr>
<tr>
<td>Operator Response: Check the extension of the file.</td>
<td></td>
</tr>
</tbody>
</table>
and ensure the it is ".js" for JavaScript or ".vba" for Visual Basic.

CTZJRM161E  FATAL ERROR: The following exception occurred while reading the script FILE_NAME: EXCEPTION.
Explanation:  No additional information is available for this message.
Operator Response:  Check to make sure the script is a text file and you have permission to read it.

CTZJRM162E  FATAL ERROR: The interps specified: INTERPS, were not found in the supported interps list: SUPPORTED.
Explanation:  The interps specified to add must exactly match the interps that the RMB supports
Operator Response:  Verify the interps are correct.

CTZJRM163E  FATAL ERROR: An interp may not be added to a VRM file.
Explanation:  VRM files only support win32 as a platform.
Operator Response:  Use a JRM to specify any other platform.

CTZJSE100E  An error occurred while creating the temporary file for debugging.
Explanation:  A .tmp file is created for debugging. An error was found doing this.
Operator Response:  A .tmp file is created in the Windows temp location. An error happened while this file was being written. Make sure user has write permissions.

CTZJSE101E  The temporary file to write to was not found.
Explanation:  The .tmp file used for debugging was not found.
Operator Response:  A .tmp file is created in the Windows temp location. An error happened while this file was being written to. Make sure user has write permissions.

CTZJSE102E  An error occurred while writing the script to the temp file.
Explanation:  The .tmp file for debugging could not be written to.
Operator Response:  A .tmp file is created in the Windows temp location. An error happened while this file was being written to. Make sure user has write permissions.

CTZJSE103E  An error occurred while loading an image.
Explanation:  An image was attempted to be loaded and an error occurred.
Operator Response:  A .tmp file is created in the Windows temp location. An error happened while this file was being written to. Make sure user has write permissions.

CTZJSE104E  An error has occurred in the JavaScript Editor plugin and a trace log has been created.
Explanation:  An error occurred in the JavaScript Editor plugin. A trace log has been created in the Tivoli common log directory under "CTZ\FFDC\Current Date\".
Operator Response:  A critical error has happened. The log files need to be checked.

CTZRM001E  Unknown
Explanation:  An unexpected error has occurred.
Operator Response:  Click details in the error window to see more information.

CTZRM002E  Cannot open FILE_NAME. Wrong editor for FILE_NAME.
Explanation:  The Resource Model Builder only handles files with the extensions, jrm and vrm. This message might also be generated if you were opening an older .dmjsws or .dmws file and cancelled the conversion wizard.
Operator Response:  Make sure the file you are opening has the proper extension. Make sure the Javascript and VBA Editor plug-ins are enabled.

CTZRM003E  An error occurred while saving the file FILE_NAME.
Explanation:  An error occurs during the save operation for the specified file.
Operator Response:  Check the details section of the dialog for more information.

CTZRM004E  Perl was not found your system's PATH. Event actions and calls to Svc.Shell will not work without this. Would you like to see this message in the future?
Explanation:  The ITM engine uses perl to launch event actions and Svc.Shell scripts
Operator Response:  If perl is not installed install it. Also make sure perl.exe is in the PATH for the system.
CTZRME007E Unable to find a script editor extension point for this file type.
Explanation: This could happen if the file name does not end with vrm or jrm. It could also happen if the JavaScript Editor or Visual Basic Editor plugin is not available.
Operator Response: Make sure the file has the proper extension. If it does, check the eclipse .log file to see if the Visual Basic or JavaScript plug-ins were disabled.

CTZRME009E An error occurred while creating the editor pages.
Explanation: This error occurs from an IBM Eclipse SDK core error.
Operator Response: Check the metadata’s .log file for more information.

CTZRME010E Failed to delete CLASS
Explanation: The specified class was not delete by the operation.
Operator Response: Make sure you have credentials to delete the class, and that the class is not a read-only class.

CTZRME012E Failed to rename VALUE_0 to VALUE_1
Explanation: No additional information is available for this message.
Operator Response: Make sure you are trying to name the class to a name valid according to the CIM specification.

CTZRME014E Could not logon to namespace\nNS
Explanation: The RMB was unable to connect to a WMI namespace.
Operator Response: Make sure WMI is running on the computer you specified, the namespace exists, and you have proper credentials to log into the namespace.

CTZRME016E Could not add class by that name.
Explanation: A class by that name might already exist in the namespace, or the name entered may be invalid.
Operator Response: Change the class name to make it valid and unique.

CTZRME018E The DM Classic Probe from the file VALUE_0 could not be imported. Verify that the file is valid and that the preprocessing options are correct.
Explanation: No additional information is available for this message.
Operator Response: Follow the instructions detailed in the error message.

CTZRME019E The DM Classic Probe from the file VALUE_0 could not be imported. Verify that the file is a valid dumped Monitoring Collection.
Explanation: No additional information is available for this message.
Operator Response: Follow the instructions detailed in the error message.

CTZRME023E An error occurred while retrieving the members of an object.
Explanation: This occurs when the RMB is trying to find all the resources contained by projects in the workspace.
Operator Response: Make sure the resources on the file system are in sync with the IBM Eclipse SDK.

CTZRME026E An error occurred while retrieving markers.
Explanation: The RMB checks to make sure resource models have no errors before it generates an IBM Tivoli Monitoring package. The RMB was unable to check this.
Operator Response: Check the IBM Eclipse SDK metadata’s .log file.

CTZRME027E An error occurred while trying to write to the file: VALUE_0
Explanation: A problem occurred while trying to write the model to disk
Operator Response: Make sure you have write access to the location on disk. Check the IBM Eclipse SDK metadata’s .log file.

CTZRME035E The current resource model contains errors.
Explanation: The resource models contains errors as listed in the Problems view.
Operator Response: Correct the errors and save the resource model.
CTZRME037E • CTZTWE005E

CTZRME037E An error occurred while attempting to retrieve the information for this model.

Explanation: Check that the file still exists.
Operator Response: Check that the file still exists.

CTZRME042E An error occurred while trying to extract dependency VALUE_0. Errors may occur while debugging your resource model if it is dependent on this.

Explanation: No additional information is available for this message.
Operator Response: Check the IBM Eclipse SDK metadata’s .log file.

CTZRME044E An error occurred while handling the selection of the item [0].

Explanation: No additional information is available for this message.
Operator Response: This error should not happen and is indicative of a defect. Please report this to IBM Tivoli Resource Model Builder Support.

CTZRME045E An error has occurred in the Resource Model Editor plugin and a trace log has been created.

Explanation: An error occurred in the Resource Model Editor plugin. A trace log has been created in the Tivoli common log directory under "CTZ\FFDC\Current Date".
Operator Response: Check the trace log file.

CTZRME046E An error occurred while compiling the MOF file.

Explanation: No additional information is available for this message.
Operator Response: Check the output of the mofcomp command in the window to see what happened.

CTZRME047E An error occurred while exporting the probes and dependencies.

Explanation: No additional information is available for this message.
Operator Response: Check the details section in the window to see what happened. This can also be seen in the IBM Eclipse SDK metadata’s .log file.

CTZRME048E An error occurred while generating the DM Classic Probes file.

Explanation: No additional information is available for this message.
Operator Response: Check the details section in the window to see what happened. This can also be seen in the IBM Eclipse SDK metadata’s .log file.

CTZTWE001W The Tivoli Management Nature was not added to the selected item VALUE_0, because it is an unknown selection type.

Operator Response: Only projects can have a project nature added to them. Make sure the selected item was a project.

CTZTWE002E An error occurred while trying to add Tivoli management capabilities to the project

Operator Response: An IBM Eclipse SDK exception occurred while adding the nature. Check the IBM Eclipse SDK .log file and First Failure Data Capture trace logs for more detailed information.

CTZTWE003I No extensions of com.ibm.tivoli.management.wizard were found

Operator Response: This is simply an information message stating that no extensions to the extension point were found. This is normal if no plugins are installed that supply extension to this particular extension point.

CTZTWE004E The class VALUE_0 is invalid for the extension point com.ibm.tivoli.management.wizard.

Operator Response: An invalid extension class was specified for the com.ibm.tivoli.management.wizard extension point. Check that the class specified in the plugin.xml file for the offending plugin implements the necessary interface.

CTZTWE005E An error has occurred in the Tivoli Workbench Environment plugin and a trace log has been created.

Explanation: An error occurred in the Tivoli Workbench Environment plugin. A trace log has been created in the Tivoli common log directory under "CTZ\FFDC\Current Date".
CTZVBE000E  An error occurred while opening the file \textit{FILE\_NAME}.

\textbf{Explanation:}

\textbf{Operator Response:} When used as a standalone editor, an open failed. Check the logs and that the file exists and is not corrupted.

CTZVBE001E  An error occurred while saving the file \textit{FILE\_NAME}.

\textbf{Explanation:} When used as a stand alone editor, a save failed.

\textbf{Operator Response:} When used as a standalone editor, a save failed. Check the logs and that the user has write permissions.

CTZVBE002E  An error has occurred in the Visual Basic Editor plugin and a trace log has been created.

\textbf{Explanation:} An error occurred in the Visual Basic Editor plugin. A trace log has been created in the Tivoli common log directory under "CTZ\FFDC\Current Date\".

\textbf{Operator Response:} A critical error has happened. The log files need to be checked.
Chapter 5. Trace logging and First Failure Data Capture

Note: Trace logs contain detailed internal information and require an internal understanding. These logs are for use only by IBM Software Support.

Trace logging and First Failure Data Capture (FFDC) are built into the software to assist IBM Software Support in gathering information to determine why a problem is occurring. If you encounter an issue, IBM Software Support might ask you to obtain the trace logging and FFDC information to review the information. This chapter introduces trace logging and FFDC and explains how to locate these sources.

Trace logging captures information about the operating environment when the code fails to operate as intended.

First Failure Data Capture (FFDC) captures and stores, in one particular instant, the tracing information preceding an error message.

All components of IBM Tivoli Resource Model Builder fully support tracing and logging through the JLog Toolkit. Each component has its own configurable trace logger. The tracing has a minimal set of methods that are always traced in an in-memory cache to provide FFDC information that is dumped when necessary. The trace loggers are configurable through the IBM Eclipse SDK plug-in preferences. They provide multiple levels of tracing.

For more information about configuration of the trace logging, see Chapter 6, “Logging configuration,” on page 27

Trace logging overview

Trace logs capture information about the operating environment when component code fails to operate as intended. These logs are in the English language only. IBM Software Support uses the information captured by trace loggers to trace a problem to its source or to determine why an error occurred. Generally, this information is not enabled by default, but logging can be enabled without stopping the application.

Each major component has its own trace logger. These include the following components:

- JRM — Java Resource Model
- JSE — Java Script Editor
- RME — Resource Model Editor
- TWE — Tivoli Workbench Environment
- VBE — Visual Basic for Applications Editor

Trace log location

Trace logging is kept in a configurable number of rotating log files. The log file names follow the format “traceRMB.log, traceRMB1.log...” where traceRMB.log is the most recent log file.

You can retrieve trace logs in the following location:
where:

<IESinstalldir>

Identifies the name of the IBM Eclipse SDK installation directory.

**Trace log format**

The trace log record format is as follows:

```
Date1<F> Date2<F> ProductID<F> Component<F> Server<F> ProcessID<F>
TraceLevel<F> FileName<F> Method<F> Thread<F> LogText<F> Exception
```

Where:

**Date1** Time the log was produced specified in milliseconds, since January 1st 1970, for example, 1015343592000.

**Date2** Date the log was produced in year, month, day format.

**ProductID** The three-letter code assigned to the product that uniquely identifies its messages. The product ID for IBM Tivoli Resource Model Builder is CTZ.

**Component** Represents a run-time grouping of a product’s parts. If a product has multiple applications, the component name reflects the name of the application.

**Server** Host name on which the program is running.

**ProcessID** The Process ID of the process that produced the log message. It is only present for Java processes.

**TraceLevel** The level of detail the trace represents, which can be one of the following:

- **MAX** The maximum level of tracing follows the paths of most of the code and provide a detailed program flow. This level includes minimum and medium level tracing as well.

- **MID** The medium level of tracing follows the paths of some high level APIs and their parameters. This level includes Minimum level tracing as well.

- **MIN** The minimum level of tracing provides some information about the program state with only a minimal impact on the performance of the program.

See "Logging preference window" on page 27 for more information about setting these levels.

**FileName** Name of the file or class to which the trace refers.

**Method** The method in the class to which the trace refers.

**Thread** Thread to which the trace refers. Thread element refers to the platform-specific notion of a thread.
LogText
A description of the error.

Exception
Exception element depends upon the specific language/platform. For Java, it is a stack trace.

Trace log example

The following text shows an example of a trace recorded in the trace log:

<F>1052255017756<F>2003-05-06<F>CTZ<F>RME<F>superhost<F>1<F>MIN<F>
com.ibm.tivoli.monitoring.workbench.view.RMEResourceViewContributor@b46421d<F>
addResourceManagers<F>main<F>adding rm adapters for project test<F>None

Where:

1052255017756  Time the log was produced specified in milliseconds, since January 1st 1970.

2003-05-06  Date the log was produced in year, month, day format.

CTZ  The three letter code assigned to the product that uniquely identifies its messages. The product ID for IBM Tivoli Resource Model Builder is CTZ.

RME  Represents a run-time grouping of a product’s parts. If a product has multiple applications, the component name reflects the name of the application.

superhost  Host name on which the program is running.

1  The Process ID of the process that produced the log message. It is only present for Java processes.

MIN  The level of detail the trace represents, in this case, minimum.

com.ibm.tivoli.rmb.ui.view.RMEResourceView...  Name of the file or class to which the trace refers.

addResourceManagers  The method in the class to which the trace refers.

main  Thread to which the trace refers. Thread element refers to the platform-specific notion of a thread.

adding rm adapters for project test  A description of the error.

None  Exception element will depend upon the specific language/platform. For Java, it is a stack trace.

First Failure Data Capture overview

First Failure Data Capture (FFDC) is an in-memory tracing tool that is continually running. When an unexpected error occurs, FFDC dumps the trace information to a log file for use in analyzing the problem. FFDC is intended primarily for use by IBM Software Support. It runs automatically, and you cannot start or stop it. If you experience conditions requiring you to contact IBM Software Support, your support representative can assist you in reading and analyzing the FFDC log. FFDC does not affect the performance of the IBM Tivoli Resource Model Builder.
By default, FFDC trace logging is set to log at the minimum level. The in-memory queue of trace events has a capacity of 10,000 trace events and when the queue fills, the next trace event replaces the oldest event already in the queue. A dump of these trace events triggers when an error message is logged.

To enable FFDC to store the logging data, you must select the **Enable trace logging to files** option on the Output page. For information about the Output page, see “Output window” on page 28.

You can retrieve FFDC logs in the following location:

<IESinstalldir>/eclipse/workspace/.metadata/tivoli/CTZ/FFDC/<date>

where:

<IESinstalldir>
Identifies the name of the IBM Eclipse SDK installation directory.

<date>
Lists the date of the FFDC log in the year, month, day format.

---

**Native trace logging**

IBM Tivoli Resource Model Builder provides configuration options to specify the levels at which the native code logs and traces. See Chapter 6, “Logging configuration,” on page 27 for configuration information.
Chapter 6. Logging configuration

IBM Tivoli Resource Model Builder logging options can be configured after installation. If you are experiencing problems, IBM Software Support might ask you to configure logging and tracing information. This chapter explains how to configure the product to provide logging data.

Configuration options

You can configure trace, message, and native code logging by using the Logging preference window, the Output window, or the native code logging window.

CAUTION:
If you turn off message or trace loggers, important FFDC information might be lost. Do not turn off logging unless instructed by IBM Software Support.

Logging preference window

You can perform all logging configuration on the Logging preference window. Access the preference window from the IBM Eclipse SDK by doing the following:
1. Click Window to display the Window drop-down list.
2. Click Preferences to display the Preferences window.
3. Click the plus-sign next to Tivoli Management to display the Tivoli Management outline.
4. Click Logging to display the Logging window.
The window displays the following information:

- **Name** — The name of each logger. You cannot edit this column.
- **Description** — A description of each logger. You cannot edit this column.
- **Level** — The level of each logger. This column contains changeable combo boxes with the different levels to which a logger can be set as selectable items.
- **Logging** — Turns each logger on and off. This column contains changeable combo boxes with On and Off as selectable items.

A hierarchical set of levels controls the output of the loggers. Message and trace loggers have unique hierarchical levels:

- **Message log hierarchy**
  - **Error** — Used for messages in which a program error has occurred.
  - **Warning** — Used for messages in which an unexpected result was received and may or may not be an indication of a problem.
  - **Info** — Used for messages providing the user with information that does not indicate a problem occurred.

- **Trace log hierarchy**
  - **Minimum** - The Minimum level of tracing provides some information about the program state with only a minimal impact on the performance of the program.
  - **Medium** - The Medium level of tracing follows the paths of some high level APIs and their parameters. This level includes Minimum level tracing as well.
  - **Maximum** - The Maximum level of tracing follows the paths of most of the code and provide a detailed program flow. This level includes Minimum and Medium level tracing as well.

Because JLog does not programmatically differentiate between message and trace loggers, you must use the description or name of the logger to determine which set of levels is most appropriate.

**Output window**

Use the Output window to customize your trace or message log settings. Access the output page from the IBM Eclipse SDK by doing the following:

1. Click **Window** to display the **Window** drop-down list.
2. Click **Preferences** to display the Preferences window.
3. Click the plus-sign next to **Tivoli Management** to display the **Tivoli Management** outline.
4. Click the plus-sign next to **Logging** to display the **Logging** outline.
5. Click **Output** to display the Output window.
The window displays the following information:

**Log file directory**
Specifies the location of the log file directory.

**Maximum number of revolving trace files**
Specifies the number of trace files that will be used and reused to store the trace file data.

**Maximum size of each trace file (in Kilobytes)**
Specifies the maximum size in kilobytes for each of the revolving trace files.

**Maximum number of revolving message files**
Specifies the number of message files that will be used and reused to store the message data.

**Maximum size of each message file (in Kilobytes)**
Specifies the maximum size in kilobytes for each of the revolving message files.

**Maximum disk space for captured data (in Bytes)**
Specifies the maximum amount of disk space to store data captured by FFDC.

**Enable trace logging to files**
*(Optional)* Check this box to store the trace logging data.

**Enable logging to console**
*(Optional)* Check this box to send logging information to a development console.

**Note:** If you enable this option, you must restart the IBM Tivoli Resource Model Builder as described in the following procedure:
2. Launch a DOS prompt.
3. CD to the <IESInstallDir>eclipse directory, where <IESInstallDir> is the installation directory for the IBM Eclipse SDK.

4. Run the following command to start IBM Tivoli Resource Model Builder with an additional DOS window to display the logging output:
   
eclipse.exe -vm <IESInstallDir>eclipse\jre\bin\java.exe

   where <IESInstallDir> is the installation directory for the IBM Eclipse SDK.

   Additional Information: If the path to eclipse.exe is not defined, use the following command:
   
   <IESInstallDir>eclipse\eclipse.exe
   -vm <IESInstallDir>eclipse\jre\bin\java.exe

5. Close the window at any time.

**Native code logging window**

You can configure the level to which the native code logs data.

**Note:** Any changes made to the native logging configuration require you to restart IBM Eclipse SDK.

Access the native logging configuration window from the IBM Eclipse SDK by doing the following:

1. Click **Window** to display the **Window** drop-down list.
2. Click **Preferences** to display the **Preferences** window.
3. Click the plus-sign next to **Tivoli Management** to display the **Tivoli Management** outline.
4. Click the plus-sign next to **Logging** to display the **Logging** outline.
5. Click **Resource Model Builder** to display the native logging configuration window.
The window displays the following information:

**Prompt when internal name changes occur.**
This option does not pertain to logging configuration. You can skip this option if you are concerned only with log data configuration. As additional information, this selected option prompts you when internal name changes occur.

**Logfile name**
Specifies the path and name of the log file that stores the logging data. By default, this is C:\Default.log. You can choose to rename and redirect this log file by typing in a new name or path to store this file.

**Logging level**
Specifies the level of detail for your log file from 0 to 4, where 0 provides the least information and 4 provides the most information. By default, this value is set to 0.

**Logfile size (in KiloBytes): 500**
Specifies the maximum size of the log file. The left or right arrow decreases and increases the maximum size. By default, this file is 500 KB. File contents are overwritten with new log data after the file is full. You can increase the size of this file to delay the content overwrite process.

**Log to standard output stream**
Select to log to standard output stream. By default, this option is not selected.

Note: If you enable this option, you must restart the IBM Tivoli Resource Model Builder as described in the following procedure:
2. Launch a DOS prompt.
3. CD to the `<IESInstallDir>\eclipse` directory, where `<IESInstallDir>` is the installation directory for the IBM Eclipse SDK.

4. Run the following command to start IBM Tivoli Resource Model Builder with an additional DOS window to display the logging output:

   `eclipse.exe -vm <IESInstallDir>\eclipse\jre\bin\java.exe`

   where `<IESInstallDir>` is the installation directory for the IBM Eclipse SDK.

5. Close the window at any time.
Appendix A. Accessibility

Accessibility features help a user who has a physical disability, such as restricted mobility or limited vision, to use software products successfully. The major accessibility features in IBM Tivoli Resource Model Builder enable users to:

- Use assistive technologies such as screen-reader software and a digital speech synthesizer to hear what is displayed on the screen
- Operate specific or equivalent features using only the keyboard
- Magnify what is displayed on the screen

In addition, the product documentation has been modified to include features to aid accessibility:

- All documentation available in both HTML and convertible PDF formats to give the maximum opportunity for users to apply screen-reader software.
- All images provided with alternative text so that users of the documentation with vision impairments can understand the contents of the images.

Using assistive technologies

Assistive technology products such as screen-readers, function with both the text-based and graphical user interfaces found in IBM Tivoli Resource Model Builder. Consult the assistive technology product documentation for specific information about using it to access command line or graphical interfaces.

Magnifying what is displayed on the screen

In all components of IBM Tivoli Resource Model Builder other than the Web Health Console, users can magnify the screens used by the product’s user interfaces using facilities provided by the operating systems on which the product is run. For example, in a Windows environment you can change the screen settings to a lower resolution to enlarge the font sizes of the text on the screen. Information about these facilities is provided in the relevant operating system documentation.

Documentation in accessible formats

All user documentation is provided in HTML format, which can be read directly by assistive tools such as screen readers, or in convertible PDF format. Convertible PDF files are those that can be converted from PDF to HTML by the Adobe PDF to HTML converter. For information about converting PDF documents to HTML, refer to the Adobe book Optimizing Adobe PDF Files for Accessibility

Using alternative text

All documentation images are provided with an alternative text that can be read by assistive tools such as screen readers.
Appendix B. Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM's application programming interfaces.

If you are viewing this information in softcopy form, the photographs and color illustrations might not display.
Trademarks

AIX, DB2, IBM, the IBM logo, IBMLink, Informix, OS/2, OS/400, Tivoli, the Tivoli logo, Tivoli Enterprise Console, and TME are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

Intel, the Intel Inside logos, MMX, and Pentium are trademarks of Intel Corporation in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows NT are registered trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service marks of others.
# Index

## A
- accessibility vii
- Accessibility 33

## B
- books
  - accessing online vi
  - feedback on vi
  - online vi
  - ordering vi

## F
- First Failure Data Capture 23, 25

## I
- IBM Software Support vii

## L
- logging
  - about 1
  - First Failure Data Capture 23
  - message 13
  - trace 23

## M
- manuals
  - accessing online vi
  - feedback on vi
  - online vi
  - ordering vi
  - message 15
    - error 15
    - informational 15
    - warning 15
  - message log 13
    - format 13
    - location 13

## O
- online publications
  - accessing vi
  - ordering publications vi, vii

## P
- publications
  - accessing online vi
  - feedback on vi
  - online vi
  - ordering vi

## S
- software support vii

## T
- Tivoli Software Information Center vi
- trace logging 23
- typeface conventions viii